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Agilent Technologies, Inc., Automation Solutions, 5301 Stevens Creek Blvd., Santa Clara, CA 95051 USA

Letter to our Customers

Dear Customer,

The Agilent Technologies acquisition of Velocity11 resulted in the following 
changes:

• Creation of Agilent Technologies Automation Solutions, formerly Velocity11

• Renaming of some Velocity11 products

• New Customer Service and Technical Support contact information

• New website address for product information

Please make a note of the following changes as they impact this user guide.

Velocity11 product name changes

New contact information
Documentation feedback: documentation.automation@agilent.com

Technical Support: 1.800.979.4811 or +1.408.345.8011 
service.automation@agilent.com

Customer Service: 1.866.428.9811 or +1.408.345.8356 
orders.automation@agilent.com

European Service: +44 (0)1763853638  
euroservice.automation@agilent.com

Web: www.agilent.com/lifesciences/automation

Velocity11 product name Changes to …

Access2 Automated Microplate 
Loader

Automated Centrifuge Loader

Element Automation System BioCel 900 System

IWorks Device Driver Programming 
Interface

VWorks Device Driver Interface

PlatePierce Seal Piercing Station Microplate Seal Piercer

VCode Barcode Print and Apply 
Station

Microplate Barcode Labeler

Velocity11 Robot 3- Axis Robot

VHooks Integration Interface VWorks Hooks Interface

VPrep Pipetting System Vertical Pipetting Station

VSpin Microplate Centrifuge Microplate Centrifuge

VStack Labware Stacker Labware Stacker

Agilent Technologies

mailto:service.automation@agilent.com
mailto:orders.automation@agilent.com

mailto:euroservice.automation@agilent.com

mailto:documentation.automation@agilent.com
http://www.agilent.com/lifesciences/automation
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Preface

This preface contains the following topics:

❑ “Who should read this guide” on page vi

❑ “What this guide covers” on page vii

❑ “Finding your software version” on page vii

❑ “Accessing Velocity11 user information” on page viii

❑ “Reporting problems” on page ix
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Who should read this guide

About this topic This topic describes the target audience of this user guide.

Job roles and 
responsibilities

This user guide is intended to be read by the following people who use 
the VPrep™ Pipetting System (VPrep Pipettor).

Related topics

Job Role Responsibilities

Integrator Someone who writes software and 
configures hardware to enable 
integration of the hardware with the 
VPrep Pipettor.

Lab manager, administrator or 
technician

Someone who is responsible for:

❑ Installing the VPrep Pipettor

❑ Developing the protocols that use 
the VPrep Pipettor

❑ Developing the applications that 
use the VPrep Pipettor

❑ Solving the more challenging 
problems that may arise

❑ Developing training materials and 
standard operating procedures for 
operators

Operator Someone who performs the daily 
production work that uses the VPrep 
Pipettor and solves routine problems.

Your organization may choose to create 
its own procedures for operators based 
on the information in this guide.

For more information about... See...

What this guide covers “What this guide covers” on page vii

How to access different formats of 
this user guide

“Accessing Velocity11 user information” 
on page viii
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What this guide covers

What is covered This guide describes the installation, setup, and operation of the 
PrepWorks™ software.

Software version This guide documents PrepWorks version 10.0.1.

Related guides The PrepWorks User Guide should be used in conjunction with the VPrep 
Pipetting System User Guide, which describes how to set up and operate 
the VPrep Pipettor.

If you are integrating the VPrep Pipettor as a third-party device, the third-
party user documents may also be applicable.

Related topics

Finding your software version

About this topic This topic shows you some ways to find out your version of PrepWorks.

Procedure To find the PrepWorks version:

1. Start PrepWorks.

2. Choose Help > About PrepWorks.

Related topics

For more information about... See...

Reporting problems “Reporting problems” on page ix

Who should read this guide “Who should read this guide” on 
page vi

How to access different formats of 
this user guide

“Accessing Velocity11 user information” 
on page viii

For more information about... See...

PrepWorks software “PrepWorks overview” on page 1

Reporting problems “Reporting problems” on page ix
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Accessing Velocity11 user information

About this topic This topic describes the different formats of Velocity11 user information 
and explains how to access the user information.

Formats available Velocity11 user information is provided to you as:

❑ A PDF file

❑ A printed book

The information in each format is the same but each format has different 
benefits.

Where to find user 
information

PDF file

The PDF file of the user guide is on the software CD that is supplied with 
the product.

Velocity11 website

You can download the latest version of any PDF file from the Velocity11 
website at www.velocity11.com.

Note: All Velocity11 user information can be searched from the website 
at www.velocity11.com.

PDF user guides Computer requirements

To open a user guide in PDF format, you need a PDF viewer. You can 
download a free PDF viewer from the internet.

Printing and searching

The user guides in PDF format are mainly for printing additional copies. 
You can perform simple searches in the PDF file, although these 
searches are much slower than online help searches.

More information
For more information about using PDF documents, see the user 
documentation for the PDF viewer.

Related topics
For more information about... See...

Who should read this guide “Who should read this guide” on 
page vi

What this guide covers “What this guide covers” on page vii

http://www.velocity11.com/site/?q=node/111
http://www.velocity11.com/site/?q=node/113
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Reporting problems

About this topic This topic describes how to report hardware, software, and user guide 
problems.

Contacting 
Velocity11

If you find a problem, contact Velocity11 Technical Support using one of 
the following methods:

❑ Sending an email to service@velocity11.com or 
euroservice@velocity11.com

❑ Calling Velocity11 Technical Support at 1.800.979.4811 or 
+1.650.846.6611 outside the US

❑ Sending a bug report from within the PrepWorks software

Reporting hardware 
problems

When contacting Velocity11, make sure you have the serial number of 
the device ready. You can find the serial number label on the lower left 
side or rear of the VPrep Pipettor.

Reporting software 
problems

When reporting software problems, provide the following:

❑ Software version number

❑ Relevant software files

Finding the software version number

When you contact Velocity11 Technical Support, make sure you have 
the software version number ready. To find the PrepWorks version 
number, see “Finding your software version” on page vii.

Sending files

When resolving software bugs or other problems, send the following 
files:

❑ Detailed, precise description of the problem you are experiencing

❑ Protocol files (if the issue occurs during a protocol run or 
simulation)

❑ Protocol log file (if the issue occurs during a protocol run)

❑ Velocity11 registry files from the Microsoft® Windows® registry

❑ Error message text (or screen capture of the error message window)

❑ Screen capture of the About PrepWorks dialog box

Reporting user guide 
problems

If you find a problem with this user guide or have suggestions for 
improvement, send your comments using one of the following methods:

❑ Click the feedback button ( ) in the online help.

❑ Send an email to documentation@velocity11.com.

mailto:service@velocity11.com
mailto:euroservice@velocity11.com
mailto:documentation@velocity11.com
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PrepWorks overview 1
This chapter contains the following topics:

❑ “PrepWorks description” on page 2

❑ “PrepWorks user interface overview” on page 4

❑ “Relationships of PrepWorks components” on page 6

❑ “PrepWorks workflow” on page 9

❑ “Installing PrepWorks” on page 10

❑ “Uninstalling PrepWorks” on page 12
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2

PrepWorks description

About this topic This topic provides an overview of the PrepWorks features.

What PrepWorks 
software does

The PrepWorks software provides automated control of the VPrep 
Pipetting System (VPrep Pipettor). The VPrep Pipettor is an automated 
liquid-handling platform that dispenses liquid accurately and precisely 
into microplates.

You can use the PrepWorks software to control a standalone VPrep 
Pipettor. 

Depending on your permission level, the PrepWorks software enables 
you to:

❑ Set up the VPrep Pipettor using the VPrep Diagnostics utility. VPrep 
Diagnostics contains tools for creating profiles, setting teachpoints, 
and configuring accessory shelves.

❑ Define labware and liquids using the Labware Editor and Liquid 
Library Editor utilities.

❑ Create and run protocols. 

❑ Perform real-time VPrep Pipettor manipulation and troubleshooting 
using the VPrep Diagnostics utility.

About integrated 
VPrep Pipettors

To control a VPrep Pipettor that is integrated with:

❑ A Velocity11 lab automation system. See the corresponding 
automation software user guide. 
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❑ A third-party lab automation system. You can use the PrepWorks 
automation interface. For details, see “Using the automation 
interface” on page 83.

Contact Velocity11 Technical Support for more information about 
the automated control of a VPrep Pipettor.

About protocols PrepWorks protocols control the tasks that the VPrep Pipettor performs. 
A protocol is a sequence of tasks that you run in PrepWorks. Each task 
performs an activity, such as attaching or removing tips from a 
disposable-tip pipette head.

Before running a protocol, you can use a compiler feature to check the 
protocol for logical errors that would otherwise prevent successful 
completion of the protocol.

Real-time 
manipulation and 
troubleshooting

The PrepWorks event log allows the operator to analyze each run and 
troubleshoot problems.

The PrepWorks software enables access to VPrep Diagnostics, which you 
can use to manipulate the VPrep Pipettor in real-time by sending 
individual commands. This is useful for setting up and troubleshooting 
the VPrep Pipettor.

Labware Editor and 
Liquid Library Editor

You can access the Labware Editor and the Liquid Library Editor 
through PrepWorks. 

❑ Labware Editor. Stores labware definition information.

❑ Liquid Library Editor. Stores information about the liquid classes.

Labware and liquids definitions can be copied onto other integrated 
devices in a lab automation system or shared by multiple VPrep 
Pipettors that are controlled from the same computer.

Related topics
For information about… See…

PrepWorks user interface or 
components

❑ “PrepWorks user interface 
overview” on page 4

❑ “Relationships of PrepWorks 
components” on page 6

VPrep Diagnostics VPrep Pipetting System User Guide

PrepWorks Workflow “PrepWorks workflow” on page 9
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PrepWorks user interface overview

About this topic This topic provides a brief overview of the PrepWorks user interface.

PrepWorks window The PrepWorks window contains a main work area and four palettes.

2

1

3

54 

Item Feature Description

1 Main work area Provides an area for creating and editing a 
protocol. 

During a run, the software highlights the active 
task in the protocol.

2 PrepWorks Tasks 
palette

Provides access to all the available tasks that may 
be used in a protocol.

3 PrepWorks Task 
Parameters 
palette

Enables you to set the parameters for the selected 
task in the protocol.

4 PrepWorks 
Workspace 
palette

Displays the list of open protocols, and allows you 
to select which protocol is currently displayed in 
the main work area.

5 PrepWorks Log 
palette

Displays a running event log and communication 
and status messages.
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Note: To show or hide a palette, choose View > Palettes, and then select 
the palette.

PrepWorks toolbars The PrepWorks toolbars include:

❑ Standard. Contains the buttons for standard Microsoft Windows 
commands, including New, Save, Open, Cut, Copy, and Paste.

❑ Protocol, Security, and Utility. Contain the buttons described in the 
following table.

Status bar The Status bar is located on the bottom of the PrepWorks window. It 
displays short text messages describing the current state of the software, 
the current user, and tooltips.

Button Description See…

Protocol toolbar

Start Begins the selected protocol run. “Running a protocol” on page 26

Compile Checks the protocol for errors. “Compiling and saving a protocol” on 
page 54

Pause Temporarily interrupts a protocol that is 
in progress.

“Pausing or stopping a protocol” on 
page 28

Stop Cancels the protocol that is in progress. “Pausing or stopping a protocol” on 
page 28

Security toolbar

Login Enables an authorized PrepWorks user to 
log in to the software. This provides a 
level of security by controlling access to 
software security levels.

“Logging in” on page 17

Logout Logs out the current PrepWorks user. “Logging out” on page 17

Security Enables the PrepWorks administrator to 
set up and manage user accounts.

“Managing user accounts” on page 15

Utility toolbar

Labware Starts the Labware Editor utility. “Labware Editor overview” on page 60

Liquids Starts the Liquid Library Editor utility. “About the Liquid Library Editor” on 
page 78

Diagnostics Starts the VPrep Diagnostics utility. VPrep Pipetting System User Guide

Options Starts a utility that enables customization 
of the PrepWorks log and compiler.

❑ “Configuring log options” on page 19

❑ “Configuring compiler options” on 
page 55

Reset Reinitializes the VPrep Pipettor.
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Related topics

Relationships of PrepWorks components

About this topic PrepWorks uses different components, such as file types, to run. This 
topic describes the components and how they work together.

What you should 
know

It is important to understand PrepWorks file dependencies. Changing 
the settings or options in one component will affect one or more of the 
other components. 

Definitions The following table describes the PrepWorks components.

For information about… See…

PrepWorks components “Relationships of PrepWorks 
components” on page 6

PrepWorks Workflow “PrepWorks workflow” on page 9

Component Definition See…

Protocol file A file (.prc file extenstion) that contains 
instructions for performing a run and a 
reference to the profile.

“Creating 
protocols” on 
page 29

Profile A collection of settings, stored in the 
Windows registry, that contain the 
communication and configuration settings 
(base, head type, tip size, and teachpoints) 
required to run protocols for a given VPrep 
Pipettor hardware configuration. The 
profiles also store the configured shelf 
information.

The VPrep Pipettor has no firmware, so all 
configuration settings are stored in the 
profile.

!! DAMAGE HAZARD !! Modifying 
the Microsoft Windows registry can 
cause the Microsoft Windows 
operating system to fail and cause 
damage to the VPrep Pipettor. 

VPrep Pipetting 
System User 
Guide

Teachpoint Part of the profile that tells the pipette head 
exactly where to move to perform a task for 
a particular type of labware.

VPrep Pipetting 
System User 
Guide
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Location of protocol 
files

Velocity11 recommends that you create protocol folders within the 
PrepWorks folder for storing the protocol files (*.prc). 

Component 
relationships

The following figure illustrates the most basic relationship between the 
PrepWorks components. 

The following table describes the consequences of making changes to 
one or more components.

Labware 
library

Labware definitions and classes stored in 
the Windows registry.

“Setting 
labware 
definitions” on 
page 59

Liquid 
library 

Pipetting settings, setup for different liquid 
types, stored in the Microsoft Windows 
registry.

“Setting liquid-
handling 
definitions” on 
page 77

User 
database

List of user accounts, privileges, and 
passwords stored in the Microsoft Windows 
registry.

“Managing 
user accounts” 
on page 15

Component Definition See…

Teachpoint ProfileLabware
library

Liquid 
library

Protocol

If you… Then…

Make a change to the teachpoint All protocols that use those profiles are 
affected.

Create a new profile You must specify the new profile in your 
protocol.
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Related topics

Want to copy a protocol to another 
system or computer

To copy the following, you must export 
the appropriate registry files to the 
destination computer:

❑ Labware and liquid libraries

❑ Profile

You must also copy the protocol file 
(*.prc) to the destination computer.

If you… Then…

For information about… See…

Getting started with the PrepWorks 
software

“PrepWorks workflow” on page 9

Exporting registry files “Moving or sending a registry file” on 
page 20

Creating profiles and setting 
teachpoints

VPrep Pipetting System User Guide
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PrepWorks workflow

About this topic This topic presents the PrepWorks workflow.

The workflow for operating the VPrep Pipettor in a third-party lab 
automation system might differ. For details, refer to the third-party user 
documentation.

Workflow

Related topics

Step Procedure See…

1 Install PrepWorks. “Installing PrepWorks” on 
page 10

2 Log in to PrepWorks. “Logging in and out” on page 17

3 Set up user accounts. “Managing user accounts” on 
page 15

4 Define the labware. “Adding labware definitions” on 
page 63

5 (Optional) Define the liquid 
classes.

“Creating liquid classes” on 
page 79

6 Create protocols. “Creating a protocol” on page 30

7 Prepare the VPrep Pipettor for a 
run.

VPrep Pipetting System User 
Guide

8 Start the protocol run. “Running a protocol” on page 26

9 (Optional) Optimize liquid 
classes.

“Creating liquid classes” on 
page 79

For information about… See…

Setting up VPrep Pipettor, 
including creating profiles and 
setting teachpoints

VPrep Pipetting System User Guide
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Installing PrepWorks

About this topic Velocity11 installs the software on the computers that are provided by 
Velocity11. If your system contains a computer from a different source, 
you can install the PrepWorks from the provided PrepWorks CD.

Before you begin Ensure the computer system meets the following requirements at a 
minimum:

❑ Pentium 4, 2 GHz or faster

❑ 256 MB RAM

❑ Windows 2000 or Windows XP

❑ 50 GB free hard disk space

!! IMPORTANT !! Installing PrepWorks and VWorks software on 
the same computer will create a software conflict.

Installing PrepWorks To install the PrepWorks software:

1. Insert the PrepWorks CD into the computer CD drive.

2. In Microsoft Windows Explorer, double-click the Setup.exe file on 
the CD. The PrepWorks InstallShield Wizard appears.

3. Follow the instructions that appear on each screen. 

After installing PrepWorks, you can find a Start menu shortcut for 
starting the software: Start > All Programs > Velocity11 > PrepWorks.
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Installing registry 
keys

The registry keys store all the instrument-specific information, such as 
liquid and labware definitions, teachpoints, and shelf configurations. 
The registry keys are stored in the Microsoft Windows registry file on the 
computer. You must have administrative privileges for the Windows 
registry to make any changes to the registry file. To receive permission, 
see your IT administrator.

The PrepWorks software CD contains registry keys for your VPrep 
Pipettor configuration.

To install the registry keys:

1. Insert PrepWorks software CD in the computer CD drive.

2. Navigate to and open the files on your CD drive.

3. Double-click the icon:

PrepWorks Base Serial Number w_Head Serial Number.reg 

For example, PrepWorks 00500001 w_0050256.

4. When a message appears and asks if you want to change the registry, 
click Yes.

5. When a confirmation message appears stating that the information 
was successfully entered, click OK.

6. Repeat step 3 to step 5 for the shared registry keys. The shared keys 
are named as:

shared date month day year.reg

Related information
For information about… See…

Exporting Velocity11 data from 
the registry 

“Moving or sending a registry file” on 
page 20

Setting up PrepWorks “Setting up PrepWorks” on page 13
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Uninstalling PrepWorks

About this topic This topic describes how to uninstall PrepWorks.

When to remove 
Velocity11 registry 
files

In general, it is sufficient to uninstall the PrepWorks program without 
removing the registry files. However, you can remove the Velocity11files 
from the registry if: 

❑ You want to make a completely fresh start with PrepWorks, removing 
all user accounts, teachpoints, profiles, and liquid and labware 
definitions

❑ You do not intend to run PrepWorks on your system again

!! DAMAGE HAZARD !! Modifying the Microsoft Windows 
registry can cause the Microsoft Windows operating system to fail 
and cause damage to the VPrep Pipettor. 

Procedures To remove PrepWorks:

1. Use the Add / Remove Programs control panel. 

For more information, see the online help for your Windows 
operating system.

!! IMPORTANT !! The following procedure deletes the user 
accounts, labware definitions, liquid library data, device profiles, 
and teachpoints. 

To remove the Velocity11 files from the registry:

1. On the Windows desktop, choose Start > Run.

2. In the Run dialog box, type regedit and then click OK.

The Registry Editor dialog box opens.

3. Navigate to and select the following folder:

HKEY_LOCAL_MACHINE\SOFTWARE\Velocity11

4. Make sure you have selected the Velocity11 folder. 

!! IMPORTANT !! Making a mistake and deleting the wrong 
registry folder can cause critical failures with your operating 
system.

5. Select Edit > Delete.

Related information
For information about… See…

Exporting Velocity11 data from the 
registry files (for example, before 
clearing the registry)

“Moving or sending a registry file” on 
page 20
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Setting up PrepWorks 2
This chapter contains the following topics:

❑ “Starting PrepWorks” on page 14

❑ “Managing user accounts” on page 15

❑ “Logging in and out” on page 17

❑ “Changing your password” on page 18

❑ “Configuring log options” on page 19

❑ “Moving or sending a registry file” on page 20
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Starting PrepWorks

About this topic This topic describes how to start PrepWorks.

Before you start 
PrepWorks

See the VPrep Pipetting System User Guide for instructions on starting up 
the VPrep Pipettor. 

Note: If the VPrep Pipettor has Pump Modules, the Pump Modules must 
be turned on prior to turning on the VPrep Pipettor.

!! INJURY HAZARD !! Do not start PrepWorks while touching the 
VPrep Pipettor. Automatic motion begins without warning. Keep 
clear of the VPrep Pipettor while it is in motion.

Starting PrepWorks To start PrepWorks:

1. Make sure that everyone is clear of the VPrep Pipettor and that there 
are no objects that could obstruct any moving parts.

2. On the Microsoft Windows desktop, double-click the PrepWorks 
shortcut icon.

Alternatively, choose Start > All Programs > Velocity11 > PrepWorks.

When you start PrepWorks, the VPrep Pipettor motors initialize and 
home the pipette head. 

Note: If you start the PrepWorks software without first starting the 
connected VPrep Pipettor, the following error message appears.

Related topics
For information about… See…

Starting up VPrep Pipettor VPrep Pipetting System User Guide

How to log in “Logging in and out” on page 17

Setting up user accounts “Managing user accounts” on page 15

Starting a protocol “Workflow for performing a run” on 
page 24
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Managing user accounts
A

About this topic This topic is for the PrepWorks administrator. This topic describes the 
different types of user accounts and how to set up and delete accounts.

User permission 
levels

The PrepWorks software provides five different permission levels as 
defined below.

!! DAMAGE HAZARD !! Ensure that each user is assigned the 
proper access permission. Improper access by untrained personnel 
could result in damage to the VPrep Pipettor. For example, if an 
untrained operator gained access to VPrep Diagnostics and edited a 
profile or set a teachpoint incorrectly, the pipette head could collide 
with a shelf. 

Logging in as 
administrator

To log in to PrepWorks as the administrator:

1. On the PrepWorks toolbar, click Login. The User Authentication dialog 
box appears.

2. From the User Name list, select Admin. 

3. Type the Password and click OK.

Permission level Description

Administrator Full access to the PrepWorks software.

Technician Full access, except to the User Editor dialog box 
and the VPrep Diagnostics Motor Config tab.

Operator Access only to:

❑ Open and run protocols, but not to edit or save 
protocols. 

❑ VPrep Diagnostics IO tab, Jog Teach tab, and 
Processes tab

Guest Access only to open protocols, but not to run, edit, 
or save protocols. 

No access Access limited to logging in.

The administrator can assign the No access level to 
accounts that are not active, but should not be 
deleted from the system.
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Note: If this is the first time anyone has logged in to PrepWorks, 
there is one administrator account called Admin. By default the 
password is blank.

Adding and deleting 
user accounts

To add User Account: 

1. Log in to the PrepWorks software as an administrator.

2. On the toolbar in the PrepWorks window, click Security. The User 
Editor dialog box appears.

3. Click Add. 

4. In the User name box, type the name of the new user over the words 
New User.

5. In the Access level list, select the user permission level. For a 
description of the levels, see “User permission levels” on page 15.

6. (Optional) To set the initial password, click Change password. 

Note: The default password is blank.

7. Click OK.

To delete a user account:

1. Log in to the PrepWorks software as an administrator.

2. On the toolbar in the PrepWorks window, click Security. The User 
Editor dialog box appears.

3. Select the name in the User name list, and then click Delete. 

4. When the message appears and asks you to confirm the deletion, 
click Yes. 

Related topics
For information about… See…

Changing your password “Changing your password” on page 18

Changing the log parameters “Configuring log options” on page 19
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Logging in and out

About this topic To log in to the PrepWorks software you must have a user account 
created by an administrator. If you do not have a user account, see your 
PrepWorks administrator.

Logging in To log in to PrepWorks:

1. On the PrepWorks toolbar, click Login. The User Authentication 
dialog box appears.

2. From the User Name list, select your account name. 

3. Type the Password and click OK.

Note: Your access level to the software is determined by your 
login account. See the PrepWorks administrator to change your 
permission level (“Managing user accounts” on page 15).

Logging out Make sure you log out of PrepWorks after completing your work. Logging 
out of PrepWorks ensures that unauthorized users do not use your 
account to control the VPrep Pipettor.

!! DAMAGE HAZARD !! Failure to log out could result in 
improper access by an untrained user. Improper access by 
untrained personnel could result in damage to the VPrep Pipettor. 

To log out of PrepWorks:

1. On the toolbar in the PrepWorks window, click Logout.

Related topics
For information about… See…

How to open a protocol “Opening a protocol in PrepWorks” on 
page 25

Creating user accounts and user 
permission levels

“Managing user accounts” on page 15
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Changing your password

About this topic If you have one of the following permission levels, you can change the 
password for your user account using the procedure in this topic:

❑ Administrator

❑ Technician

❑ Operator

Procedure To change the password:

1. On the PrepWorks toolbar, click Login. The User Authentication 
dialog box appears.

2. Select account from the User Name list, and then click Change 
password. The Change Password dialog box appears.

3. Type the current password in the Old box, and type the new 
password in the New and Confirm New boxes.

4. Click OK to set the password, and then click OK to exit the User 
Authentication dialog box.

Related topics
For information about… See…

Creating user accounts and user 
permission levels

“Managing user accounts” on page 15

Job roles and responsibilities “Who should read this guide” on 
page vi
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Configuring log options

About this topic The PrepWorks Log palette in the main window displays a running event 
log, communication, and status messages. PrepWorks stores the 
messages in a log file.

To configure the log options, you must have PrepWorks Technician or 
Administrator privileges. For more details on access levels, see 
“Managing user accounts” on page 15.

Changing log 
options 

To change the log options:

1. On the PrepWorks toolbar, click Options. The PrepWorks Options 
dialog box appears.

2. Click the Log Options tab.
.

3. To change the log file storage location, click Browse. In the Browse for 
Folder dialog box, select the destination folder, and click OK.

Note: By default, the file is stored in 
\\Program Files\Velocity11\PrepWorks

4. In the Number of log files to maintain box, type or select the number.

5. In the Number of lines to keep in log window type or select the 
number of lines that appear in the PrepWorks Log palette.

6. Under Log to File, select the type information to be saved to the log 
file.

7. Under Log to Window, select the type of information to be displayed 
in the PrepWorks Log palette.

8. Click OK to save the changes and close the dialog box.
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Related topics

Moving or sending a registry file

About this topic This topic provides instructions on how to export a Windows registry 
file. You export the registry file so that you can import the registry 
information to another computer or to email the registry file to 
Velocity11.

When to do this You might need to copy or send a registry file in the following situations:

❑ To make a backup of a VPrep Pipettor profile

❑ To transfer a VPrep Pipettor profile from one computer to another

❑ To email the labware or liquid library or VPrep Pipettor profile when 
requested by personnel at Velocity11

About moving data The labware and liquid libraries and profiles are maintained in the 
Windows registry of the controlling computer. 

If you make a change to the labware or liquids definitions or a profile, 
you can use a two-step process to propagate the change to another 
computer. 

1. Export the Windows registry key containing the data to a file.

2. Import the file to the other computer’s registry.

Damage hazard !! DAMAGE HAZARD !! Use caution when working with the 
Windows registry. Making a mistake when editing the registry can 
cause critical failures with your operating system.

Exporting a registry 
key

To export a registry key:

1. From the Windows Start menu, select Run.

2. In the Open text box, type regedit, and click OK.

The Windows registry editor opens.

For information about… See…

PrepWorks user interface or 
components

❑ “PrepWorks user interface 
overview” on page 4

❑ “Relationships of PrepWorks 
components” on page 6

PrepWorks Workflow “PrepWorks workflow” on page 9

User permissions “Managing user accounts” on page 15
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3. Expand the registry folders to display and select one of the following 
folders:

HKEY_LOCAL_MACHINE\SOFTWARE\Velocity11\Shared\Labware
\Labware_Entries

HKEY_LOCAL_MACHINE\SOFTWARE\Velocity11\Shared\Liquid 
Library

HKEY_LOCAL_MACHINE\SOFTWARE\Velocity11\device 
name\Profiles

4. From the Registry (or File) menu, select Export.

The Export Registry File dialog box opens.

5. Before saving the file, make sure you: 

Select Selected branch.

If you are moving the file to a computer with a different 
Windows operating system, set Save as type appropriately.

6. Save the file.

7. Select Registry > Exit (or File > Exit) to close the registry editor.

Importing a registry 
key

If this is the first time you are importing a registry file to the computer, 
use the Open With command.

Before you start
You must have Windows Administrator permissions to perform this task.

To import a registry key:

1. Copy the registry file to any location on the recipient computer. If 
necessary, change the file extension from *.re_ to *.reg.

2. On the recipient computer, double-click the registry file.

3. Click Yes when the confirmation message appears. 

The information in the file is written automatically to the registry and 
this will be confirmed with a message.

Note: When importing labware definitions, the labware class must be 
reassigned.

Emailing a registry 
file

Occasionally, you might be asked to send a registry file to Velocity11. 
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To email a registry file:

1. Export the Windows registry key containing the data to a file.

2. Change the file extension to .re_ (This is necessary because many 
firewalls do not allow *.reg files to be emailed.) 

3. Email the file.

Related topics
For information about… See…

Creating VPrep Pipettor profiles VPrep Pipetting System User Guide

Defining labware “Setting labware definitions” on 
page 59

Defining liquid classes “Setting liquid-handling definitions” on 
page 77

PrepWorks Workflow “PrepWorks workflow” on page 9
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Performing a run 3
This chapter describes how to run an existing PrepWorks protocol on the 
VPrep Pipettor. The procedures in this chapter can be performed by a 
user with PrepWorks Operator privileges.

This chapter contains the following topics:

❑ “Workflow for performing a run” on page 24

❑ “Opening a protocol in PrepWorks” on page 25

❑ “Running a protocol” on page 26

❑ “Monitoring the run” on page 27

❑ “Pausing or stopping a protocol” on page 28
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Workflow for performing a run

About this topic This topic tells you where to find the information about starting a run 
and performing tasks associated with running a protocol.

Workflow

Related topics

Step Task See...

1 Perform pre-run checks and 
prepare for a run.

VPrep Pipetting System User Guide

2 Open the protocol. “Opening a protocol in PrepWorks” 
on page 25

3 Start the protocol run. “Running a protocol” on page 26

4 Monitor the run. “Monitoring the run” on page 27

5 Clean up after the run. VPrep Pipetting System User Guide

6 If finished with PrepWorks 
tasks, log out of PrepWorks.

“Logging in and out” on page 17

For information about… See…

Pausing or stopping a run “Pausing or stopping a protocol” on 
page 28

Stopping in an emergency VPrep Pipetting System User Guide

Shutting down the VPrep Pipettor VPrep Pipetting System User Guide
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Opening a protocol in PrepWorks 

About this topic This topic describes how to open a protocol that has already been 
created.

Opening a protocol !! INJURY HAZARD !! Do not open a protocol while touching the 
VPrep Pipettor. Automatic motion begins without warning. Keep 
clear of the VPrep Pipettor while it is in motion.

To open a protocol:

1. In the PrepWorks window, choose File > Open. 

2. In the Open window, select the protocol file (.prc file extension), and 
then click Open.

Related topics
For information about… See…

Creating a protocol “Creating a protocol” on page 30

Running a protocol “Running a protocol” on page 26
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Running a protocol

About this topic This topic describes how to run a PrepWorks protocol on the VPrep 
Pipettor.

Before you start !! IMPORTANT !! Make sure you have prepared the VPrep 
Pipettor for a run. See the VPrep Pipetting System User Guide.

Running the 
Protocol

To run the protocol:

1. In the PrepWorks window, open the protocol.

2. If you have not already checked the protocol for errors, click Compile 
on the toolbar.

When the Compile complete! message appears, click OK.

3. Click Start.

The Start button becomes unavailable and the Pause button 
becomes available.

4. Monitor the progress of the run.

Related topics
For information about… See…

Checking a protocol for errors “Compiling and saving a protocol” on 
page 54

Perparing for a run VPrep Pipetting System User Guide

Monitoring the progress of the run “Monitoring the run” on page 27

Pausing or stopping a run “Pausing or stopping a protocol” on 
page 28

Performing an emergency stop VPrep Pipetting System User Guide
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Monitoring the run

About this topic After starting a run, the operation of the system should be monitored 
appropriately. Exactly what you do to monitor a run depends on your 
system and the protocol that you are using. 

Monitoring overall 
progress

You can monitor the following:

❑ In the PrepWorks work area, a highlight appears on each task icon in 
the protocol while that task is being run.

❑ In the PrepWorks Log palette, progress messages appear. The log files 
record events as they are performed on all plates in the run.

❑ If User Message tasks are included in the protocol, you are prompted 
to respond to them.

❑ Depending on the protocol, you might be required to add and 
remove labware, empty liquid waste containers, or fill liquid 
reservoirs.

!! IMPORTANT !! No errors are reported when a liquid waste 
container becomes full or a liquid reservoir becomes empty. 
Exceptions to this are reservoirs on a Weigh Shelf.

Note: To guard against the problem of a full waste container or empty 
reservoir container, the protocol writer can incorporate User Message 
tasks into the protocol to remind the operator at the appropriate steps in 
the protocol. Alternatively, operators can set timer alarms to remind 
them to fill reservoirs and empty the waste container at the appropriate 
time.

Related topics
For information about… See…

Changing the log options “Configuring log options” on page 19

Pausing or stopping a run “Pausing or stopping a protocol” on 
page 28

Performing an emergency stop VPrep Pipetting System User Guide
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Pausing or stopping a protocol

About this topic This topic describes how to perform a normal stop or pause a protocol.

For details on how to perform an emergency stop, see the VPrep 
Pipetting System User Guide.

!! DAMAGE HAZARD !! Do not turn off the power switch on the 
rear panel of the VPrep Pipettor to stop a run. When you turn on the 
power again, the protocol cannot resume, and the shelf movement 
could result in a pipette head crash.

Pausing and 
resuming a protocol

To pause and resume a protocol:

1. On the toolbar in the PrepWorks window, click Pause. 

The motion stops after the last command is finished, and the Pause 
button label changes to Start.

2. To resume a paused protocol, click Start. 

Stopping a protocol You cannot resume a stopped protocol.

To stop a protocol that is running:

1. On the toolbar in the PrepWorks window, click Stop. The motion 
stops after the last command is finished. 

Related topics
For information about… See…

How to stop a run in an 
emergency 

VPrep Pipetting System User Guide

How to contact Velocity11 
Technical Support

“Reporting problems” on page ix

How to log out of PrepWorks “Logging in and out” on page 17
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Creating protocols 4
The procedures in this chapter can be performed by a user with 
PrepWorks Technician or Administrator privileges. 

This chapter contains the following topics:

❑ “Creating a protocol” on page 30

❑ “About protocol tasks” on page 32

❑ “Setting the Configure Shelves parameters” on page 34

❑ “Configuring Tip Change parameters” on page 36

❑ “Specifying a quadrant of a plate” on page 38

❑ “Configuring Aspirate parameters” on page 40

❑ “Configuring Dispense parameters” on page 42

❑ “Configuring Mix parameters” on page 45

❑ “Configuring Reservoir parameters” on page 49

❑ “Configuring a Loop” on page 51

❑ “Configuring User Message parameters” on page 52

❑ “Compiling and saving a protocol” on page 54
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Creating a protocol

About this topic You use PrepWorks protocols to control the tasks that the VPrep Pipettor 
performs. 

To create a protocol you must have PrepWorks Technician or 
Administrator privileges. For more details on access levels, see 
“Managing user accounts” on page 15.

Before you begin Make some reference notes describing the goal of the protocol and 
listing the tasks, labware, and volumes required. Reference notes can 
help to maintain your focus while using the PrepWorks software to 
create the protocol.

Ensure the following:

❑ The labware definitions and the liquid classes have been defined.

❑ You know how each shelf on the VPrep Pipettor is going to be 
configured.

❑ Any accessories, such as the Pump Module and Weigh Shelf, have 
been properly installed and configured.

❑ The correct profile has been initialized.

❑ You have any scripts that you want to use for the protocol tasks.

Workflow The basic workflow for creating a protocol consists of the following:

Creating a protocol You can create a new protocol or you can copy a protocol to use as a 
template for creating a new protocol. 

To create a new PrepWorks protocol:

1. Make sure the PrepWorks Tasks palette appears in the PrepWorks 
window. 

To show a hidden palette, choose View > Palettes.

2. Choose File > New. The Start and End icons appear in the blank work 
area, as shown in the following figure.

Step Topic

1 “Creating a protocol” on page 30

2 “Adding and arranging tasks” on page 31

3 “About protocol tasks” on page 32

4 “Compiling and saving a protocol” on page 54
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To create a protocol from a copy:

1. In the PrepWorks window, choose File > Open.

2. In the Open dialog box, select the protocol file (*.prc), and then 
click OK. The protocol appears in the work area of the PrepWorks 
window.

3. Choose File > Save As. 

4. In the Save As dialog box, type the file name of the new protocol, 
and click Save. 

5. Edit the copied protocol as necessary.

Adding and 
arranging tasks

To add a task to the protocol:

1. Drag and drop tasks from the PrepWorks Tasks palette onto the main 
work area, between the Start and End icons. 

The first task after Start is typically the Configure Shelves task, which 
specifies which labware is on the VPrep Pipettor shelves.

2. Configure the parameters for each task that you add to the protocol. 
See “About protocol tasks” on page 32.

To delete a task from the protocol:

1. In the work area of the PrepWorks window, highlight the task, and 
then press DELETE.

Note: To highlight multiple tasks simultaneously, you can use 
SHIFT+click or CTRL+click.

To rearrange tasks in the protocol:

1. In the main work area of the PrepWorks window, drag the task icons 
to the desired positions. Alternatively, you can cut and paste the task 
icons.
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Related information

About protocol tasks

About this topic A PrepWorks protocol is a sequence of tasks that you run to control the 
VPrep Pipettor operation. Each task performs an activity. This topic 
describes the tasks that are available for use in the PrepWorks protocols.

Task descriptions Each task is represented by an icon in the PrepWorks Task palette. Each 
task has associated parameters that are defined in the PrepWorks Task 
Params palette.

The following table lists the tasks available to PrepWorks protocols.

For information about… See…

Defining labware “Labware Editor overview” on page 60

Defining liquids “About the Liquid Library Editor” on 
page 78

Setting up the VPrep Pipettor and 
initializing profiles

VPrep Pipetting System User Guide

Running a protocol “Workflow for performing a run” on 
page 24

Contacting Velocity11 “Contacting Velocity11” on page ix

Task Description See…

Configure Shelves Specifies the type of labware 
that goes on each VPrep 
Pipettor shelf. 

Use this task at the beginning 
of a protocol and any time in 
the protocol that you want the 
user to change the labware on 
a shelf. 

“Setting the Configure 
Shelves parameters” 
on page 34

Tips On For a disposable-tip pipette 
head, attaches the tips from a 
tipbox that is on either shelf 7 
or shelf 8.

“Configuring Tip 
Change parameters” 
on page 36

Tips Off For a disposable-tip pipette 
head, detaches the used tips 
into an empty tipbox on 
either shelf 7 or shelf 8.

“Configuring Tip 
Change parameters” 
on page 36
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Related topics

Tip Dry Not supported.

Aspirate Draws liquid from a plate or 
reagent tray into the pipette 
tips.

“Configuring Aspirate 
parameters” on 
page 40

Dispense Releases liquid from the 
pipette tips into a plate or 
reagent tray.

“Configuring Dispense 
parameters” on 
page 42

Mix Aspirates and dispenses 
liquid in a single plate or 
reservoir repeatedly to mix 
the liquid.

“Configuring Mix 
parameters” on 
page 45

Reservoir Controls the filling and 
emptying of a reservoir using 
the Pump Module.

“Configuring 
Reservoir parameters” 
on page 49

Loop Defines a segment of the 
protocol to be repeated a 
specified number of times.

“Configuring a Loop” 
on page 51

User Message Inserts a text message with 
user interaction into the 
protocol.

“Configuring User 
Message parameters” 
on page 52

Task Description See…

For more information about… See…

Creating protocols “Creating a protocol” on page 30

Defining labware “Setting labware definitions” on 
page 59

Compiling and saving a protocol “Compiling and saving a protocol” on 
page 54

Running a protocol “Workflow for performing a run” on 
page 24



Chapter 4: Creating protocols
PrepWorks User Guide

34

Setting the Configure Shelves parameters

About this topic The Configure Shelves task associates each VPrep Pipettor shelf with the 
particular plate type (labware). 

Use Configure Shelves at the beginning of a PrepWorks protocol and any 
time in the protocol that you want the user to change the labware on a 
shelf. Configure Shelves provides an option to pause the protocol and 
prompt the user to manually place the plates on the shelves. 

Procedure To set the Configure Shelves parameters:

1. With the protocol displayed in the PrepWorks work area, highlight 
the Configure Shelves or the Pause to verify shelf configuration task 
icon. 

The PrepWorks Task Params palette displays the Configure Shelves 
settings.

2. Select the appropriate labware from the list for each shelf.

Note: The shelf lists contain entries from the Labware Editor, 
which contains full geometrical definitions of all labware to be 
used with the VPrep Pipettor. All labware used in the protocol 
must be configured in the Labware Editor. 

3. To prompt the user to manually place or identify the appropriate 
labware on the shelves, select the Pause protocol to confirm shelf 
configuration check box.

If this box is selected, the Verify Shelf Configuration dialog box 
appears when a Configure Shelves task runs during the protocol.
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Related topics
For more information about… See…

All the available protocol tasks in 
PrepWorks

“About protocol tasks” on page 32

Creating protocols “Creating a protocol” on page 30

Defining labware “Setting labware definitions” on 
page 59

Compiling and saving a protocol “Compiling and saving a protocol” on 
page 54

Running a protocol “Workflow for performing a run” on 
page 24
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Configuring Tip Change parameters

About this topic To change the tips on a disposable-tip pipette head, you use the Tips On 
task to attach the tips from a tipbox and you use the Tips Off task to 
detach the used tips. This topic describes how to configure the 
parameters for these tasks in the protocol.

Configuring Tips On 
parameters

The Tips On task instructs the VPrep Pipettor to attach new tips to the 
pipette head.

To configure the Tips On task:

1. With the protocol displayed in the PrepWorks work area, highlight 
the Tips On task icon. 

The PrepWorks Task Params palette displays the Tip Change settings.

2. In the Shelf to use list, select the tipbox shelf.

Note: Only shelf 7 or shelf 8 are available for the Tips On task 
because of their proximity to the tipbox press.

3. Ensure that the selected shelf has been configured as the tipbox 
shelf in the Configure Shelves task. 

4. In the Quadrant graphic, specify which tips to attach. This step 
applies only if the pipette head has fewer tips than the plate has 
wells or if you are in serial-dilution mode. 

Configuring Tips Off 
parameters

The Tips Off task instructs the VPrep Pipettor to detach and eject the 
disposable tips.
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To configure the Tips Off task:

1. With the protocol displayed in the PrepWorks work area, select the 
Tips Off task icon. 

The PrepWorks Task Params palette displays the Tip Change settings.

2. In the Shelf to use list, select the tipbox shelf.

Note: Only shelf 7 or shelf 8 are available for the Tips Off task.

3. Ensure that the selected shelf has been configured as the tipbox 
shelf in the Configure Shelves task. 

Related topics
For more information about… See…

All the available protocol tasks in 
PrepWorks

“About protocol tasks” on page 32

Configuring the VPrep Pipettor 
shelves

“Setting the Configure Shelves 
parameters” on page 34

Specifying a plate quadrant for the 
task

“Specifying a quadrant of a plate” on 
page 38

Compiling and saving a protocol “Compiling and saving a protocol” on 
page 54

Running a protocol “Workflow for performing a run” on 
page 24
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Specifying a quadrant of a plate

About this topic If the pipette head has fewer tips than the labware has wells, such as in 
serial-dilution mode, specify the target quadrant.

About plate 
quadrants

When a task acts on some but not all of the pipettes, the Quadrant 
graphic allows you to specify the target wells.

A quadrant is one-quarter of the wells on a plate. The wells selected are 
determined by how the pipette head configuration lines up with the 
configuration of the plate’s wells. 

The wells that comprise a quadrant are not contiguous. For example, 
suppose you have a 96-tip head and a 384-well plate. If you divide the 
plate wells into groups of four, you can represent the quadrants as: 

❑ A1 represents the quadrant of all the upper left wells from each of 
the groups of four. 

❑ A2 represents the quadrant of all the upper right wells from each of 
the groups of four.

❑ B1 represents the quadrant of all the lower left wells from each of the 
groups of four.

❑ B2 represents the quadrant of all the lower right wells from each of 
the groups of four.
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Selecting a quadrant To select a quadrant of wells:

1. In the Quadrant graphic, click a well that represents the set of wells 
that comprise the desired quadrant. All wells in that quadrant are 
selected.

2. To select a different quadrant, click a well that represents the set of 
wells of the new quadrant, and then click a well from the previous 
quadrant to deselect all its wells.

Note: Clicking a well in a deselected quadrant, selects the quadrant. 
Clicking a well in a selected quadrant, deselects the quadrant. You can 
select any quadrant individually, any configuration of two or three 
quadrants, or all quadrants.

Related topics

A1

B1

A2

B2

For more information about… See…

All the available protocol tasks in 
PrepWorks

“About protocol tasks” on page 32

Creating protocols “Creating a protocol” on page 30

Defining labware “Setting labware definitions” on 
page 59

Compiling and saving a protocol “Compiling and saving a protocol” on 
page 54

Running a protocol “Workflow for performing a run” on 
page 24
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Configuring Aspirate parameters

About this topic The Aspirate task draws liquid or air from a source plate or reservoir into 
the pipette tips. This topic describes how to set the Aspirate task 
parameters.

Procedure To configure the Aspirate parameters:

1. With the protocol displayed in the PrepWorks work area, highlight 
the Aspirate task icon. 

The PrepWorks Task Params palette displays the Aspirate settings.

2. Select the Shelf from which to aspirate. 

3. To specify a liquid class to aspirate, select the liquid class from the 
unlabeled list at the bottom of the PrepWorks Task Params palette.

4. Configure the volume parameters as follows:

a. Pre-aspirate volume. Type the volume of air (µL) to draw into the 
tips before drawing the fluid.
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b. Aspirate volume. Type the volume of fluid (µL) to draw into each 
pipette tip.

c. Post-aspirate volume. Type the volume of air (µL) to draw into 
the pipette tips after drawing the fluid.

5. In the Quadrant graphic, specify the quadrants from which to 
aspirate. 

Note: Quadrants appear after you select the shelf with the 
corresponding labware.

6. In the Tips distance from well bottom box, specify the tip position 
(mm) at which to aspirate. 

!! IMPORTANT !! The labware definition must be accurate 
and the teachpoint must be precise in order for the system to 
position the tips at the correct distance from the well bottom.

Note: If you are using dynamic tip extension, this value sets the 
lowest point to which the tips will travel.

7. In the area at the bottom of the Task Params palette, specify the 
following. 

Note: If you selected a liquid class, the velocity and acceleration 
values are entered automatically from the Liquid Library Editor 
and cannot be edited here.

a. Aspirate velocity. Specify the speed (µL/s) at which to draw 
liquid into the tips.

b. Aspirate acceleration. Specify the rate of increase in velocity (µL/
s²) before the maximum aspirate velocity is reached.

8. In the Dynamic tip extension box, specify the rate at which to move 
the pipette head down for each microliter aspirated. The software 
calculates the distance over which the tips will move without 
crashing.

For example, if you want the tips to move at the same rate of change 
that the liquid level is dropping, use the following formula:

1/cross-sectional area of the well (mm2)

Note: Dynamic tip extension can prevent overflow in wells that 
are very full. If fluids of different viscosities are present, you can 
use this parameter to aspirate the fluid of a specific viscosity.

Related topics
For more information about… See…

All the available protocol tasks in 
PrepWorks

“About protocol tasks” on page 32

Defining liquids “Setting labware definitions” on 
page 59

Defining labware “Setting labware definitions” on 
page 59



Chapter 4: Creating protocols
PrepWorks User Guide

42

Configuring Dispense parameters

About this topic The Dispense task ejects liquid or air from the tips into a destination 
plate or reservoir. This topic describes how to set the task parameters.

Dispense value 
limits

The dispense volume cannot be greater than the aspirated volume.

Specifically, the Aspirate Volume + Pre-Aspirate Volume + Post-Aspirate 
Volume must be greater than, or equal to, Dispense Volume + Blowout 
Volume + Post Dispense Volume.

If you enter a total dispense volume that is greater than the total aspirate 
volume, an error message will appear when you compile the protocol. 

Procedure To configure the Dispense task:

1. With the protocol displayed in the PrepWorks work area, highlight 
the Dispense task icon. 

The PrepWorks Task Params palette displays the Dispense settings.

Configuring the VPrep Pipettor 
shelves

“Setting the Configure Shelves 
parameters” on page 34

Specifying a plate quadrant for the 
task

“Specifying a quadrant of a plate” on 
page 38

Compiling and saving a protocol “Compiling and saving a protocol” on 
page 54

Running a protocol “Workflow for performing a run” on 
page 24

For more information about… See…
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2. Select the target shelf from the Shelf list. 

3. To specify a liquid class, select the liquid class from the unlabeled 
list at the bottom of the PrepWorks Task Params palette.

4. Configure the volume parameters as follows:

a. Dispense volume. Type the volume of fluid (µL) to release into 
the well.

b. Blowout volume. Type the volume of airspace (µL) to push 
through the pipette tips after dispensing, while the tips are still in 
the wells.

c. Post-dispense volume. Type the amount of airspace (µL) ejected 
from the pipette tips after the tips have moved out of the wells.

5. Select the Flush Tips check box if you want all the fluid and air to be 
ejected from the tips without specifying the volume.

6. In the Quadrant graphic, specify the quadrants from which to 
aspirate.

Note: Quadrants appear after you select the shelf with the 
corresponding labware. 

7. In the Tips distance from well bottom box, specify the pipette tip 
position (mm) at which to dispense. 

Note: If you are using dynamic tip retraction, this value sets the 
lowest point to which the tips will travel.
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8. To specify that the pipette tips touch one or more sides of the wells, 
select the Tip Touch check box and set the following:

a. Tip touch rise height. Type the vertical distance (mm) for the 
pipette tips to rise from the dispense height before tip touching 
commences. For example, you can specify a location just above 
the surface of the liquid.

b. Tip touch horizontal distance. Type the horizontal distance (mm) 
for a tip to move. The value is based on the well diameter 
specified by the plate type, for example:

c. Tip touch sides to touch. Type the number of well sides that you 
want the tips to touch, where

0 – None

1 – North

2 – North, East

3 – North, East, South

4 – North, East, South, West

9. In the area at the bottom of the PrepWorks Task Params palette, 
specify the following:

Note: If you selected a liquid class, the velocity and acceleration 
values are entered automatically from the Liquid Library Editor 
and cannot be edited here.

a. Dispense velocity. The rate at which to dispense the liquid.

b. Dispense acceleration. The rate of increase in velocity before the 
dispense velocity is reached.

c. Dynamic tip retraction. The rate at which to raise the pipette head 
for each microliter dispensed. 

For example, if you want the tips to move at the same rate of 
change that the liquid level is dispensing, use the following 
formula:

1/cross-sectional area of the well (mm2)

Related topics

Value Result

0 Tips move a horizontal distance equal to the well 
radius

> 0 Tips attempt to move past the well radius, which results 
in a more forceful tip touch

< 0 Tips move a distance less than the radius of the well, 
resulting in a lighter tip touch

For more information about… See…

All the available protocol tasks in 
PrepWorks

“About protocol tasks” on page 32



45Chapter 4: Creating protocols
PrepWorks User Guide

Configuring Mix parameters
A

About this topic The Mix task aspirates and dispenses a liquid sample in a single plate or 
reservoir repeatedly to mix the liquid. The Mix task can be used to mix 
samples or to wash the pipette tips in a reservoir, such as the MicroWash 
Reservoir or Auto Filling Reservoir. This topic describes how to set the 
task parameters.

Procedure To configure the Mix task:

1. With the protocol displayed in the PrepWorks work area, highlight 
the Mix task icon. 

The PrepWorks Task Params palette displays the Mix settings.

Defining liquids “Setting labware definitions” on 
page 59

Defining labware “Setting labware definitions” on 
page 59

Configuring the VPrep Pipettor 
shelves

“Setting the Configure Shelves 
parameters” on page 34

Specifying a plate quadrant for the 
task

“Specifying a quadrant of a plate” on 
page 38

Compiling and saving a protocol “Compiling and saving a protocol” on 
page 54

For more information about… See…
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2. Select the target shelf from the Shelf list. 

3. To specify a liquid class to dispense, select the liquid class from the 
unlabeled list at the bottom of the PrepWorks Task Params palette.

4. Configure the volume parameters:

a. Pre-aspirate volume. Type the volume of air (µL) to draw into the 
pipette tips before the first aspiration stroke.

b. Mixing volume. Type the volume of fluid (µL) to be repeatedly 
aspirated and dispensed.

c. Blowout volume. Type the volume (µL) dispensed from the tips 
following the last mix step. The tips are still in the wells.

5. Mixing cycles. Type the number of times to repeat the aspirate-
dispense cycle.

6. In the Quadrant graphic, specify the quadrants from which to 
aspirate. 

Note: Quadrants appear after you select the shelf with the 
corresponding labware. 

7. In the Tips distance from well bottom box, type the distance (mm) 
from the bottom of the well at which the mix operation will be 
performed.
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8. Select one of the following options:

Tip Touch. Adds a tip-touch operation following the last dispense.

Wash Tips. Activates tip washing and allows you to specify the 
pump speeds for autofilling reservoirs.

Neither. Turns off the Tip Touch and Dispense to Waste processes.

9. If you selected Tip Touch, specify the parameters: 

a. Tip touch rise height. Type the vertical distance (mm) for the tips 
to rise before tip touching commences.

b. Tip touch horizontal distance. Type the horizontal distance (mm) 
for a tip to move. The value is based on the well diameter 
specified by the plate type, for example:

Note: The well radius is defined in the Labware Editor entry 
for the type of plate you are using. 

c. Tip touch sides to touch. Type the number of edges of the well to 
touch, where

0 – None

1 – North

2 – North, East

3 – North, East, South

4 – North, East, South, West

10. If you selected Wash Tips, specify the parameters:

a. Inflow Pump. Type the speed (%) of the pump filling the selected 
shelf.

b. Outflow Pump. Type the speed (%) of the pump emptying the 
selected shelf.

c. Dispense to waste. If you want to perform dispense operations 
outside the chimneys of a MicroWash Reservoir, select the check 
box.

11. In the area at the bottom of the PrepWorks Task Params palette, 
configure the remaining parameters:

a. Aspirate velocity. Type the speed at which the fluid is aspirated 
during the mix cycle.

b. Aspirate acceleration. Type the rate of increase in velocity before 
the aspirate velocity is reached.

Value Result

0 Tips move a horizontal distance equal to the well 
radius

> 0 Tips attempt to move past the well radius, which results 
in a more forceful tip touch

< 0 Tips move a distance less than the radius of the well, 
resulting in a lighter tip touch
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c. Dispense velocity. Type the speed at which the fluid is dispensed 
during the mix cycle.

d. Dispense acceleration. Type the rate of increase in velocity before 
the dispense velocity is reached.

e. Dynamic tip retraction. Type the rate at which to lower the pipette 
head for each microliter aspirated and to raise the pipette head 
for each microliter dispensed.

For example, if you want the tips to move at the same rate of 
change that the liquid level is changing, use the following 
formula:

1/cross-sectional area of the well (mm2)

Related topics
For more information about… See…

All the available protocol tasks in 
PrepWorks

“About protocol tasks” on page 32

Defining liquids “Setting labware definitions” on 
page 59

Defining labware “Setting labware definitions” on 
page 59

Configuring the VPrep Pipettor 
shelves

“Setting the Configure Shelves 
parameters” on page 34

Specifying a plate quadrant for the 
task

“Specifying a quadrant of a plate” on 
page 38

Compiling and saving a protocol “Compiling and saving a protocol” on 
page 54
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Configuring Reservoir parameters

About this topic The Reservoir task is only for use with Velocity11 Pump Modules and 
Weigh Shelf accessories. 

The Reservoir task controls the automatic emptying or filling of a 
reservoir. The duration of the fill or empty operation can be specified by 
a simple timer or by using a Weigh Shelf to reach a target level in the 
reservoir. 

Procedure To configure the Reservoir task:

1. With the protocol displayed in the PrepWorks work area, highlight 
the Reservoir task icon. 

The PrepWorks Task Params palette displays the Reservoir settings.

2. Select the target shelf from the Shelf list. 

3. Select one of the following options:

Fill

Empty

4. In the Duration box, type the amount of time (ms) to empty or fill the 
reservoir.

5. In the Pump speed box, type the speed as a percentage of the pump’s 
total output to use for the fill or empty operation.

6. If the selected shelf is a Weigh Shelf:

!! IMPORTANT !! Only for use with a Velocity11 Weigh Shelf on 
the VPrep Pipettor. 

a. Select the Use weigh shelf control check box. 
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b. In the Target liquid level box, type the target level for the fill or 
empty operation.

When the target level is achieved or exceeded, the pump turns 
off. If the target level is not reached in the amount of time 
specified in the Duration parameter, the pump turns off and an 
error message displays.

7. Select the Reserve shelf until completely filled check box to prevent 
any other function from being performed on this shelf during the 
filling or emptying process.

Related topics
For more information about… See…

All the available protocol tasks in 
PrepWorks

“About protocol tasks” on page 32

Configuring the VPrep Pipettor 
shelves

“Setting the Configure Shelves 
parameters” on page 34

Defining labware “Setting labware definitions” on 
page 59

VPrep Pipettor accessories VPrep Pipetting System User Guide

Compiling and saving a protocol “Compiling and saving a protocol” on 
page 54

Running a protocol “Workflow for performing a run” on 
page 24
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Configuring a Loop 

About this topic The Loop task repeats a set of tasks within the protocol. This topic 
describes how to configure the Loop task.

Procedure Tasks within a loop are indented to indicate the start and end of the 
loop.

To create a loop:

1. With the protocol displayed in the PrepWorks work area, drag and 
drop the Loop task icon from the PrepWorks Tasks palette to the 
desired position in the protocol.

2. Highlight the Loop task icon. The PrepWorks Task Params palette 
displays the Loop settings. 

3. In the Number of times to loop box, type the number of times to 
repeat the loop within the protocol.

4. Drag and drop the first task in the loop from the PrepWorks Tasks 
palette onto the Loop task icon in the work area. The added task 
icons are nested under the Loop task icon. 
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5. Repeat step 4 for each task that you want to include in the loop. 

Note: To collapse or expand the list of tasks in the loop, click the + or – 
symbol next to the Loop task icon.

Related topics

Configuring User Message parameters

About this topic The User Message task pauses the protocol to display a message to the 
user. This topic describes how to configure the task parameters.

Procedure To configure the User Message task:

1. With the protocol displayed in the PrepWorks work area, highlight 
the User Message task icon. 

The PrepWorks Task Params palette displays the User Message 
settings.

For more information about… See…

All the available protocol tasks in 
PrepWorks

“About protocol tasks” on page 32

Creating protocols “Creating a protocol” on page 30

Defining labware “Setting labware definitions” on 
page 59

Compiling and saving a protocol “Compiling and saving a protocol” on 
page 54

Running a protocol “Workflow for performing a run” on 
page 24
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2. Type a title over the Enter a title text in the top box.

3. Type a message over the Enter a message text in the bottom box. 

When the User Message task runs, it pauses the protocol and 
displays the text message in a dialog box. The following figure shows 
an example.

The user must click OK to acknowledge the message and continue 
the protocol.
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Related topics

Compiling and saving a protocol

About this topic Before using the protocol, check for possible errors using the compile 
feature. The compile feature runs a diagnostic program that searches for 
several classes of errors in the protocol. This topic describes how to run 
the compile feature and save the protocol.

To create a PrepWorks protocol you must have Technician or 
Administrator privileges. For more details on access levels, see 
“Managing user accounts” on page 15.

Types of protocol 
errors

The following types of protocol errors can generate a compile error:

❑ Protocols that do not have a net pipetting volume of zero (there is an 
imbalance between the volume aspirated and the volume 
dispensed). 

❑ Protocols that direct the pipettor outside of its allowable volume 
range. 

❑ Protocols that direct the VPrep Pipettor to pipette from a shelf which 
has no labware assigned. 

❑ Protocols that pipette without first attaching tips, or which perform a 
Tips On or Tips Off inappropriately. 

Running the Compile 
feature

To run the Compile feature:

1. With the protocol displayed in the PrepWorks work area, click 
Compile on the toolbar. 

2. If an Error detected in protocol message appears, do one of the 
following:

Stop compiling and fix the error.

For more information about… See…

All the available protocol tasks in 
PrepWorks

“About protocol tasks” on page 32

Creating protocols “Creating a protocol” on page 30

Defining labware “Setting labware definitions” on 
page 59

Compiling and saving a protocol “Compiling and saving a protocol” on 
page 54

Running a protocol “Workflow for performing a run” on 
page 24
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Continue compiling and fix the error afterwards.

At the end of a compilation, the message Compile complete appears.

Note: If the log option settings are configured to show errors in the 
window, the message Compile failed appears in the PrepWorks Log palette 
after compiling a protocol that contains errors.

Saving a protocol After the protocol has been compiled, you can save it so that it can be 
run at a later time.

To save a protocol:

1. With the protocol displayed in the PrepWorks work area, choose 
File > Save. 

2. In the Save As dialog box, type the protocol file name and select the 
storage location. 

PrepWorks protocol files have the .prc file extension.

Related topics

Configuring compiler options

About this topic You can configure the compiler options to ignore certain types of errors.

To configure the compiler options, you must have PrepWorks Technician 
or Administrator privileges. For more details on access levels, see 
“Managing user accounts” on page 15.

Changing the 
Compiler Options

!! DAMAGE HAZARD !! The default settings for the compiler 
assume that a protocol begins with no tips on and no volume in the 
tips. Some compiler options are useful when a protocol begins with 
different conditions. However, these conditions also defeat many 
safeguards, so use care when changing the Compiler Options 
settings. 

For more information about… See…

Configuring the compile options “Configuring compiler options” on 
page 55

Configuring the log options “Configuring log options” on page 19

Running a protocol “Workflow for performing a run” on 
page 24

Logging in or out of PrepWorks “Logging in and out” on page 17

User permissions “Managing user accounts” on page 15
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To change the compiler options:

1. On the toolbar in the PrepWorks window, click Options.

2. In the PrepWorks Options dialog box, click the Compiler Options tab.

3. To specify changes under Tip verification, select the corresponding 
check box:

Allow Tips Off when tips are already on. Enables multiple Tips Off 
commands, which the VPrep Pipettor will perform, even if there 
is not a Tips On command in between.

Allow Tips On when the tips are already on. Enables multiple Tips 
On commands, which the VPrep Pipettor will perform, even if 
there is not a Tips Off command in between.

Allow liquid handling without Tips On. Enables liquid handling 
even if a Tips On command is not included in the protocol.

4. To specify changes under Debug/Troubleshooting, select the 
corresponding check box:

Allow overaspiration. Overrides a compiler error if tips aspirate 
more volume than the default capacity.

Allow overdispensing. Overrides a compiler error if the tips 
contain less volume than the specified dispense volume.

5. If you want the protocol to continue operation even if tips contain 
residual liquid, select the Volume verification – Allow protocols 
without net zero volume check box.

6. If the protocol tasks include scripts, select the Preserve scripting 
context check box to retain scripting variable values from run to run.

7. If you want the compiler to assign default labware to unconfigured 
or empty shelves, select the Shelf verification parameters as follows:

a. Select the Allow liquid handling from empty shelves check box.
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b. In the Plate geometry list, select the default labware for the 
compiler to assign to any shelf that is unconfigured or is 
configured as empty.

8. Click OK to save the settings and close the dialog box.

Related topics
For more information about… See…

All the available protocol tasks in 
PrepWorks

“About protocol tasks” on page 32

Creating protocols “Creating a protocol” on page 30

Running the compiler feature “Compiling and saving a protocol” on 
page 54
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The procedures in this chapter can be performed by a user with 
PrepWorks Technician or Administrator privileges.

This chapter contains the following topics:

❑ “Labware Editor overview” on page 60

❑ “Adding labware definitions” on page 63

❑ “Deleting a labware entry” on page 65

❑ “Renaming a labware entry” on page 66

❑ “Defining general properties for labware” on page 67

❑ “Defining plate properties” on page 68

❑ “Defining the well properties” on page 69

❑ “Inserting an image” on page 72

❑ “Defining labware classes” on page 73

Setting labware 
definitions 5
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Labware Editor overview

About this topic This topic introduces the Labware Editor features that are applicable for 
a standalone VPrep Pipettor. If you are using VPrep Pipettor as an 
integrated device, see the applicable user guide for your automation 
control software, such as the VWorks User Guide.

You must have Technician or Administrator privileges to use the 
Labware Editor to define labware. For more details on access levels, see 
“Managing user accounts” on page 15.

Labware Editor 
functions

You can use the Labware Editor to:

❑ View existing labware definitions or classes

❑ Edit labware definitions or classes

❑ Add new labware definitions or classes

❑ Delete labware definitions or classes

❑ Rename labware definitions or classes

Types of information 
stored

The Labware Editor stores two types of information:

❑ Labware physical properties. Plates, lids, tipboxes, and other labware 
have properties such as width, length, and number of wells.

❑ Labware classes. Sets of labware entries that are grouped so they are 
easier to manage.

Labware Editor 
pages

The Labware Editor has two tabbed pages:

❑ Labware Entries page. Displays the current list of labware definitions 
and allows you to add, delete, and rename labware definitions.

❑ Labware Classes page. Lists the current labware classes and allows 
you to create new classes and add and delete entries from each 
class.

Labware Entries 
page

Tabbed pages

When using VPrep Pipettor in standalone mode, the following tabs 
appear at the bottom of the Labware Entries page:

❑ Plate Properties tab. Use this tab to specify the labware thickness.

❑ BenchCel tab and Stacker tab. Not used by VPrep Pipettor in 
standalone mode. 

❑ VPrep/Well Definition tab. Use this tab to specify the well geometry 
and dimensions for the labware and tip information for disposable 
tips.

❑ Image tab. Use this tab to add a labware image to the software 
interface for the selected labware definition.
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❑ Labware Classes tab. Use this tab to add the selected labware 
definition to an existing labware class.

Labware list

The labware selection list appears in the left-hand column of each 
tabbed subpage.

Labware-Entry General Properties box

The Labware-Entry General Properties box appears on each tabbed 
subpage.

Labware Classes 
page

In the Labware Classes page, you create labware classes and assign 
defined labware to a labware class.



Chapter 5: Setting labware definitions
PrepWorks User Guide

62

Labware standards 
and considerations

!! IMPORTANT !! Use only labware that meets the American 
National Standards Institute (ANSI) standards. For the latest labware 
standards, go to www.sbsonline.org. You can also contact the 
labware manufacturer to inquire about ANSI-compliant labware.

In addition to the ANSI standards for labware, VPrep Pipettor shelves 1 
and 2 have a height restriction to ensure clearance for the pipette head. 
The maximum height of the labware that you can use on shelves 1 and 2 
is dependent on several factors, such as the type of pipette head, tip 
size, and type of shelf. 

Note: The software displays an error message if you select a labware 
definition that exceeds the maximum allowable height for shelves 1 
and 2.

http://www.sbsonline.org
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Related information

Adding labware definitions

About this topic The first step in defining labware, such as a plate, is to create a labware 
entry. To save time when creating a new entry that is similar to an 
existing one, you can copy an existing labware entry. 

This topic describes how to add a labware entry or copy an existing 
labware entry to create a new one.

The following procedures require PrepWorks Technician or 
Administrator privileges. For more details on access levels, see 
“Managing user accounts” on page 15.

Adding a labware 
entry

To add a labware definition:

1. On the PrepWorks toolbar, click Labware. The Labware Editor opens.

2. On the Labware Entries page, click New labware entry under the 
labware list on the left side.

3. In the New Labware Entry dialog box, type a name for the labware 
and click OK.

The entry appears in the labware list.

For information about… See…

Adding labware definitions “Adding labware definitions” on 
page 63

Defining the properties for the 
labware entry

❑ “Defining general properties for 
labware” on page 67

❑ “Defining plate properties” on 
page 68

❑ “Defining the well properties” on 
page 69

❑ “Inserting an image” on page 72
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Copying a labware 
entry

To copy a labware entry:

1. On the PrepWorks toolbar, click Labware. The Labware Editor opens.

2. On the Labware Entries page, select a labware entry from the list on 
the left.

3. Click Save changes as.

4. In the Save Labware Entry As dialog box, type a name for the new 
entry, and click OK.

The copied entry appears in the labware list. Edit the labware 
properties as required.

Related information
For information about… See…

Defining the properties for the 
labware entry

❑ “Defining general properties for 
labware” on page 67

❑ “Defining plate properties” on 
page 68

❑ “Defining the well properties” on 
page 69

❑ “Inserting an image” on page 72
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Deleting a labware entry

About this topic This topic describes how to delete a labware entry. 

The procedure requires PrepWorks Technician or Administrator 
privileges. For more details on access levels, see “Managing user 
accounts” on page 15.

Before you start Make sure that the entry you are deleting is not referenced in protocols.

!! IMPORTANT !! If you delete a labware entry that is referenced 
in a protocol, the protocol will not run.

Procedure To delete a labware entry:

1. On the PrepWorks toolbar, click Labware. The Labware Editor opens.

2. On the Labware Entries page, select the entry to be deleted from the 
labware list on the left side.

3. Click Delete labware entry.

4. Click Yes when the confirmation messages appears.

Related information
For information about… See…

Adding labware entries “Adding labware definitions” on 
page 63

Renaming labware entries “Renaming a labware entry” on page 66

Defining the properties for the 
labware entry

❑ “Defining general properties for 
labware” on page 67

❑ “Defining plate properties” on 
page 68

❑ “Defining the well properties” on 
page 69

❑ “Inserting an image” on page 72
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Renaming a labware entry

About this topic This topic describes how to change the name of a labware definition.

The procedure requires PrepWorks Technician or Administrator 
privileges. For more details on access levels, see “Managing user 
accounts” on page 15.

Before you start Make sure that the entry that you are renaming is not referenced in 
protocols.

!! IMPORTANT !! If you rename a labware entry that is 
referenced in a protocol, the protocol will not run.

Procedure To rename a labware entry:

1. On the PrepWorks toolbar, click Labware. The Labware Editor opens.

2. On the Labware Entries page, select the entry to be renamed, and 
click Rename labware entry.

3. When the confirmation message appears, click Yes.

4. In the Rename Labware Entry dialog box, enter the new name for the 
labware and click OK.

Related information
For information about… See…

Adding labware entries “Adding labware definitions” on 
page 63

Deleting labware entries “Deleting a labware entry” on page 65

Defining the properties for the 
labware entry

❑ “Defining general properties for 
labware” on page 67

❑ “Defining plate properties” on 
page 68

❑ “Defining the well properties” on 
page 69

❑ “Inserting an image” on page 72



67Chapter 5: Setting labware definitions
PrepWorks User Guide

Defining general properties for labware

About this topic After adding a labware entry, you define the general properties of the 
labware.

The procedure requires PrepWorks Technician or Administrator 
privileges. For more details on access levels, see “Managing user 
accounts” on page 15.

Procedure To define the general properties of a piece of labware:

1. On the PrepWorks toolbar, click Labware. The Labware Editor opens.

2. On the Labware Entries page, select an entry from the list.

3. (Optional) Type a description in the Description box.

4. (Optional) In the Manufacturer part number box, type the part 
number for the labware.

5. In the Number of wells list, select the number of wells in the plate. 

6. Under Base Class, select the type of labware.

The option you select determines which properties are available.

7. Click Save changes.

Related information
For information about… See…

Creating labware entries “Adding labware definitions” on 
page 63

Deleting labware entries “Deleting a labware entry” on page 65

What to do next ❑ “Defining plate properties” on 
page 68

❑ “Defining the well properties” on 
page 69

❑ “Inserting an image” on page 72
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Defining plate properties

About this topic This topic describes how to define properties for a plate or other piece 
of labware in the Labware Editor. 

The procedure requires PrepWorks Technician or Administrator 
privileges. For more details on access levels, see “Managing user 
accounts” on page 15.

Defining plate 
properties

To define plate properties:

1. On the PrepWorks toolbar, click Labware. The Labware Editor opens.

2. On the Labware Entries page, ensure the labware entry is selected in 
the list on the left.

3. Click the Plate Properties tab.

The following figure shows the Plate Properties sub-page parameters. 
Only the Thickness parameter is relevant for a standalone VPrep 
Pipettor.

4. Using calipers positioned across a corner of the plate, measure the 
dimension (mm) from the bottom surface to the top surface of the 
plate. 

!! IMPORTANT !! Use calipers to carefully measure the 
labware you are defining in Labware Editor.

5. Type the value in the Thickness box.

6. Click Save changes.
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Related information

Defining the well properties

About this topic This topic describes how to define the well properties of a labware entry 
in Labware Editor. 

The procedure requires PrepWorks Technician or Administrator 
privileges. For more details on access levels, see “Managing user 
accounts” on page 15.

Defining well 
properties

To define the well properties:

1. On the PrepWorks toolbar, click Labware. The Labware Editor opens.

2. On the Labware Entries page, ensure the entry is selected from the list 
on the left.

3. Click the VPrep/Well Definition tab.

4. Enter the values for the available parameters according to the type 
of labware you are defining, and then click Save changes.

The following figure shows the VPrep/Well Definition page and the table 
provides descriptions of each parameter. 

!! IMPORTANT !! Use calipers to carefully measure the labware 
you are defining in the Labware Editor.

For information about… See…

Creating a labware entry “Adding labware definitions” on 
page 63

Defining general properties “Defining general properties for 
labware” on page 67

What to do next “Defining the well properties” on 
page 69
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Property Description

Well Dimensions Enter all of the following values:

❑ Well volume. Type the value for the maximum fluid volume of one tip or 
well (µL).

❑ Well depth. Measure the internal well depth (mm) from the inside well 
bottom to the top of the plate.

❑ Well diameter. Using calipers measure the diameter of the well (mm).

Well Geometry Select the option that corresponds to the shape of the wells: Round or Square.

Well-Bottom Shape Select the option that corresponds to the shape of the well bottoms: Rounded, 
Flat, or V-Shaped.
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Related information

Well Positions !! IMPORTANT !! The Teach tip box button in VPrep Diagnostics 
can change the values for the well positions in the labware 
definition.
The software supplies the following values automatically based on the Number 
of wells selection:

❑ Row-wise teachpoint to well. Distance (mm) from the teachpoint to the 
center of the A1 well along the x direction (number axis). 
This setting should be 0 mm for standard 96-well plates and 2.25 mm for 
standard 384-well plates.

❑ Column-wise teachpoint to well. Distance (mm) from the teachpoint to 
the center of the A1 well along the y direction (letter axis). 
This setting should be 0 mm for standard 96-well plates and 2.25 mm for 
standard 384-well plates. 

❑ Row-wise well to well. Distance (mm) from well-center to well-center in 
the x direction. 
This setting should be 9 mm for standard 96-well plates and 4.5 mm for 
standard 384-well plates. 

❑ Column-wise well to well. Distance (mm) from well-center to well-center 
in the y direction. 
This setting should be 9 mm for standard 96-well plates and 4.5 mm for 
standard 384-well plates. 

Tip Parameters If the Base Class is Tip box, specify one of the following:

❑ Velocity11 tip box. Type the tip volume (µL) in the Disposable tip 
capacity box.

❑ 3rd party tip box. Type the tip volume (µL) in the Disposable tip 
capacity box. Use calipers to measure the tip length (mm), and type the 
value in the Disposable tip length box. 

Property Description

For information about… See…

Creating a labware entry (before 
defining it)

“Adding labware definitions” on 
page 63

Defining general properties “Defining general properties for 
labware” on page 67

Defining plate properties “Defining plate properties” on page 68

What to do next “Inserting an image” on page 72
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Inserting an image

About this topic This topic describes how to associate an image of the labware with the 
labware definition.

The procedure requires PrepWorks Technician or Administrator 
privileges. For more details on access levels, see “Managing user 
accounts” on page 15.

Procedure Make sure that the image file you want to add is in JPG, GIF, or BMP 
format.

To insert an image:

1. On the PrepWorks toolbar, click Labware. The Labware Editor opens.

2. On the Labware Entries page, ensure the labware entry is selected in 
the list on the left.

3. Click the Image tab. 

4. Click the Image filename browse button (...).

5. In the Open dialog box, locate and double-click the image file.

The image appears on the Image page.

6. Click Save changes.

The following figure shows an example of a labware image in the 
Labware Editor.

Related information
For information about… See…

Creating a labware entry (before 
defining it)

“Adding labware definitions” on 
page 63

Defining general properties “Defining general properties for 
labware” on page 67

What to do next “Defining labware classes” on page 73
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Defining labware classes

About this topic This topic explains how to set up labware classes. 

The procedure requires PrepWorks Technician or Administrator 
privileges. For more details on access levels, see “Managing user 
accounts” on page 15.

About labware 
classes

A labware class is a grouping of labware entries. The PrepWorks software 
comes with three labware classes already defined: 

❑ Uses Filter Platepad

❑ Uses Standard Platepad

❑ Uses Vacuum Platepad

Initially, you can choose to use only these supplied classes. However, if 
you are using an accessory, you might want to create a new class to 
restrict the type of labware that can be used on that accessory.

Two places to define 
classes

You can view and define which plate types are associated with which 
labware classes in:

❑ The Labware Classes page

❑ The Labware Classes sub-page of the Labware Entries page

These views present the same information in different ways.

About the Labware 
Classes page

In the Labware Classes page, if you select a class in the selection box on 
the left, the plate types that are members of that class are displayed in 
the far right-hand column.
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About the Labware 
Classes sub-page

On the Labware Classes sub-page, select an entry from the labware list on 
the left. The far right column displays the classes that include the 
selected labware entry.

Procedure To add a labware class:

1. On the Labware Classes page, click New labware class.

2. In the New Labware Class dialog box, type the class name and click 
OK.

The entry appears in the list of labware classes.

To add labware entries to a class:

1. On the Labware Classes page or the Labware Classes subtab on the 
Labware Entries page, select entries from the middle column and 
then click >. To select more than one entry, use SHIFT + click or 
CTRL + click. 

To move all entries, click > >.

2. To save the changes, do one of the following:
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On the Labware Entries page Labware Classes subtab, click Save 
changes.

On Labware Classes page, click Save changes as to save the new 
labware class.

Related information
For information about… See…

Creating a labware entry “Adding labware definitions” on 
page 63

Creating liquid classes “Creating liquid classes” on page 79

Creating a protocol “Creating a protocol” on page 30

Running a protocol “Workflow for performing a run” on 
page 24

Contacting Velocity11 “Contacting Velocity11” on page ix
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The procedures in this chapter can be performed by a user with 
PrepWorks Technician or Administrator privileges.

This chapter contains the following topics:

❑ “About the Liquid Library Editor” on page 78

❑ “Creating liquid classes” on page 79

Setting liquid-
handling definitions 6
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About the Liquid Library Editor

About this topic The Liquid Library Editor is used to define pipetting properties for 
liquids (liquid classes). 

You must have PrepWorks Technician or Administrator privileges to 
enter values for properties that affect pipetting speed, accuracy and 
precision. 

Liquid classes The values entered into the Liquid Library Editor can be saved as a 
collection of properties, known as a liquid class. Using liquid classes 
saves time when writing protocols because you do not have to enter 
values for the liquid properties.

When creating a protocol, you select the liquid class that you want to 
use within each liquid-handling task. Then, during the run, the liquid 
class values are referenced for pipetting operations.

Library location The software saves the data that represents a liquid class to the liquid 
library, which is maintained in the Microsoft Windows registry.

Related information
For information about… See…

Creating a liquid class “Creating liquid classes” on page 79

Creating labware definitions “Adding labware definitions” on 
page 63

Contacting Velocity11 “Contacting Velocity11” on page ix
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Creating liquid classes

About this topic This topic describes how to create a new liquid class.

This topic is for users with PrepWorks Administrator or Technician 
privileges. For more details on access levels, see “Managing user 
accounts” on page 15.

Types of liquid 
classes

You may want to create different classes for the following:

❑ Types of liquids, for example, water vs. DMSO

❑ Volumes of liquids, for example, 1 µL vs. 200 µL

❑ Liquid operations, for example, washing vs. mixing

!! INJURY HAZARD !! Velocity11 products are intended to be 
used with non-hazardous aqueous liquids. Contact Velocity11 before 
using any non-aqueous solvents, or solvents generally considered to 
be hazardous.

Creating a liquid 
class

The following figure shows the Liquid Library Editor window.

To create a liquid class:

1. On the PrepWorks toolbar, click Liquids. The Liquid Library Editor 
opens.

2. Click New liquid entry. 

3. In the New Liquid Entry dialog box, type a name for the liquid class 
and click OK. The entry appears in the liquid list on the left.
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4. In the top right box, type a description for the new liquid entry.

5. Define the aspirate and dispense parameters using the guidelines in 
the following sections.

6. Click Save changes.

Defining aspirate 
parameters

To define the aspirate parameters:

1. On the Aspirate tab, enter the aspirate parameter values. See the 
following table for guidelines.

If you want to use the same parameters for dispensing, click Copy values 
to dispense tab.

Defining dispense 
parameters

To define the dispense parameters:

1. Click the Dispense tab, and enter the dispense parameter values. See 
the following table for guidelines.

If you want to use the same parameters for aspirating, click Copy values 
to aspirate tab.

Aspirate parameter Definition

Velocity Specifies the speed (µL/s) of the aspiration 
stroke.

Acceleration Specifies acceleration (µL/s²) during the 
aspiration stroke.

Post-aspirate delay Specifies the time (ms) the pipettor waits after 
aspiration is complete before moving the tips 
out of the wells.

Z-axis velocity into wells Specifies how fast the pipettor moves (mm/s) 
as the tips enter the wells.

Z-axis acceleration into 
wells

Specifies the acceleration (mm/s²) of the 
pipettor as the tips move into the wells. 

Z-axis velocity out of wells Specifies how fast (mm/s) the tips leave the 
wells.

Z-axis acceleration out of 
wells

Specifies the pipettor acceleration (mm/s²) as 
the tips move out of the wells.

Dispense parameter Definition

Velocity Specifies the maximum speed of the 
dispensing stroke (µL/s).

Acceleration Specifies acceleration (µL/s²) during the 
dispensing stroke.

Z-axis velocity into wells Specifies how fast the pipettor moves (mm/s) 
as the tips enter the wells.
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Related information

Z-axis acceleration into 
wells

Specifies the acceleration of the pipettor (mm/
s²) as the tips enter the wells.

Z-axis velocity out of wells Specifies how fast the pipettor moves (mm/s) 
as the tips leave the wells.

Z-axis acceleration out of 
wells

Specifies the acceleration of the pipettor (mm/
s²) as the tips leave the wells.

Post-dispense delay Specifies the time (ms) the pipettor waits after 
the dispense stroke before moving the tips out 
of the wells.

Dispense parameter Definition

For information about… See…

Defining labware “Labware Editor overview” on page 60

Creating a protocol “Creating a protocol” on page 30

Running a protocol “Workflow for performing a run” on 
page 24

Contacting Velocity11 “Contacting Velocity11” on page ix
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Using the automation 
interface 7

This chapter is for use by third-party integrators who wish to control the 
VPrep Pipettor using their own interface. 

This chapter contains the following topics:

❑ “Creating the PrepWorks object with Visual Basic” on page 84

❑ “Properties” on page 85

❑ “Methods” on page 86

❑ “Events” on page 88
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Creating the PrepWorks object with Visual Basic

About this topic This topic explains how to use Visual Basic to create objects to automate 
control of the VPrep Pipettor with your interface. However, you can use 
any compatible programming software.

After you perform the following procedure, define the PrepWorks 
properties, methods, and events.

Procedure To integrate the PrepWorks library in Visual Basic

1. Start PrepWorks to register the PrepWorks type library.

Note: By starting PrepWorks for the first time, the necessary 
operating system registry files are created on your computer.

2. Start Microsoft Visual Basic and add a reference to the PrepWorks 
type library as follows: 

a. In the Microsoft Visual Basic window, choose Tools > References. 
The References dialog box appears.

b. In the References dialog box, click Browse. 

c. In the Add References dialog box, select Files of type: All Files.

d. Navigate to the PrepWorks installation location, select 
PrepWorks.exe, and then click Open.

You will now be able to create PrepWorks.Application objects in the 
Visual Basic Project:

Example Dim WithEvents PrepObj As PrepWorks.Application

Set PrepObj = new PrepWorks.Application



85Chapter 7: Using the automation interface
PrepWorks User Guide

Related topics

Properties
x

About this topic This topic defines the properties, methods, and events that are used to 
program your interface to control the VPrep Pipettor through 
PrepWorks.

Property 
descriptions

Long Visible (Read/Write)

Long EditorHandle (Read Only)

Related topics

For more information about… See…

Properties, Methods, and Events ❑ “Properties” on page 85

❑ “Methods” on page 86

❑ “Events” on page 88

Contacting technical support “Reporting problems” on page ix

Description Not Zero  = Show PrepWorks editor windowZero (default)  = 
Hide PrepWorks editor window

Example    PrepObj.Visible = True

Description Retrieves the HWnd of the PrepWorks editor window for use 
in API calls

Example    Long editorHWnd = PrepObj.EditorHandle

For more information about… See…

Using Microsoft Visual Basic “Creating the PrepWorks object with 
Visual Basic” on page 84

Methods and Events ❑ “Methods” on page 86

❑ “Events” on page 88

Contacting technical support “Reporting problems” on page ix
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Methods

Method descriptions CompileProtocol (Path as String

RunProtocol (Path as String)

InitializeHardware (Profile as String)

Login (UserName as String, Password as String)

ShowLoginDialog

Logout

PauseProtocol

Description Compiles the specified protocol

Arguments Path as String = Path to protocol file

Example PrepObj.CompileProtocol “c:\test.prc”

Description Compiles and then executes the specified protocol

Arguments Path as String = Path to protocol file

Example PrepObj.RunProtocol “c:\test.prc”

Description Initializes or reinitializes the VPrep Pipettor hardware. Homes 
motors.

Arguments Profile as String = Valid profile name, or null for last profile

Example    PrepObj.InitializeHardware “001-N-96F50”

Description Logs in a user without presenting a login dialog

Arguments UserName as String = UserName

Password as String = Password

Example    PrepObj.Login “Administrator”, “Velocity11”

Description Presents the login dialog which allows a user to log in or 
change passwords

Example  PrepObj.ShowLoginDialog

Description Logs out the current user

Example    PrepObj.Logout

Description Pauses or unpauses the currently executing protocol

Example PrepObj.PauseProtocol
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ShowDiagnosticsDialog

ShowLabwareDialog

ShowLiquidDialog

ShowOptionsDialog

ShowSecurityDialog
\

StopProtocol

Related topics

Description Displays the PrepWorks hardware diagnostics dialog

Example  PrepObj.ShowDiagnosticsDialog

Description Displays the PrepWorks labware dialog

Example PrepObj.ShowLabwareDialog

Description Displays the PrepWorks liquid classes dialog

Example    PrepObj.ShowLiquidDialog

Description Displays the PrepWorks options dialog

Example  PrepObj.ShowOptionsDialog

Description Displays the PrepWorks security editor dialog

Example PrepObj.ShowSecurityDialog

Description Aborts the currently executing protocol

Example PrepObj.StopProtocol

For more information about… See…

Using Microsoft Visual Basic “Creating the PrepWorks object with 
Visual Basic” on page 84

Properties and Events ❑ “Properties” on page 85

❑ “Events” on page 88

Contacting technical support “Reporting problems” on page ix
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Events

Events ConfigureShelves (ByVal shelfArray As Variant, displayDlg As 
Long)

FatalProtocolError (ByVal description As String, displayDlg As 
Long)

HardwareError (ByVal errorCode As Long, ByVal description As 
String, displayDlg As Long, actionToTake As Long

Description Occurs when a protocol executes the ConfigureShelves task

Arguments ByVal shelfArray as Variant = array of strings representing the 
labware being associated with the indexed shelf

DisplayDlg as Long = if not zero, PrepWorks will display the 
shelf configuration confirmation dialog, provided that the 
protocol demands this. If zero, PrepWorks will not display the 
shelf configuration confirmation dialog

Example Dim i As Integer

Dim lower As Integer

lower = LBound(shelfArray)

For i = lower To UBound(shelfArray)

MsgBox "Shelf " + CStr(1 + i - lower) + ": " + 
shelfArray(i)

Next

displayDlg = False

Description Occurs when PrepWorks detects a fatal error during the 
execution of a protocol

Arguments ByVal description as String= description of error DisplayDlg as 
Long = if not zero, PrepWorks will display an error 
messagebox. If zero, PrepWorks will not display an error 
dialog.

Example MsgBox "Fatal Error: " + description

displayDlg = False

Description Occurs when the VPrep Pipettor hardware detects an error 
condition

Arguments ByVal errorCode as Long = general errorCode

ByVal description as String = description of error

displayDlg as Long = if not zero, PrepWorks will display a 
Retry/Ignore/Abort dialog, and ignore the actionToTake 
argument. If zero, PrepWorks will not display the dialog, but 
will instead use the actionToTake argument

actionToTake as Long = (IDABORT = 3), (IDRETRY = 4), 
(IDIGNORE = 5). 

Any other values will be treated as IDRETRY
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InitializationComplete ()

LogMessage (ByVal message As String, ByVal level As Integer)

ProtocolComplete()

RecoverableProtocolError (ByVal description As String, 
displayDlg As Long, actionToTake As Long)

Example Private Const IDABORT = 3

MsgBox " ERROR (" + CStr(errorCode) + "): " + 
description

displayDlg = False

actionToTake = IDABORT

Description Occurs after a call to InitializeHardware, if the initialization is 
successful. If the initialization fails, a HardwareError will 
occur instead.

Description Generic logging event. Most everything that PrepWorks does 
generates a LogMessage event

Arguments ByVal message as String = text of log message

ByVal level as Integer = category of log event, useful for 
filtering: (PROCESS=0), (FATALERROR=1), (ERROR=2), 
(DEBUG=3)

Example MsgBox message + " : Level " + CStr(level)

Description Occurs upon completion of protocol, whether by completion, 
stop due to error, or stop due to user abort.

Description Occurs when a protocol error occurs that PrepWorks believes 
can be resolved by user intervention

Arguments ByVal description as String = description of error

displayDlg as Long = if not zero, PrepWorks will display a 
Retry/Ignore/Abort    dialog, and ignore the actionToTake 
argument. If zero, PrepWorks will not display the dialog, but 
will instead use the actionToTake argument

actionToTake as Long = (IDABORT = 3), (IDRETRY = 4), 
(IDIGNORE = 5). 

Any other values will be treated as IDRETRY

Example MsgBox "Ignoring error: " + description

displayDlg = False

actionToTake = IDIGNORE
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UserMessage (ByVal message As String, ByVal title As String, 
displayDlg As Long)

Related topics

Description Occurs when a protocol executes the UserMessage task. This 
can be used to generate arbitrary messages to the automation 
client

Arguments ByVal message as String = message parameter of UserMessage 
task

ByVal title as String = title parameter of UserMessage task

displayDlg as Long = if not zero, PrepWorks will display a 
dialog with the message and title. If zero, PrepWorks will not 
display a dialog

Example MsgBox "Protocol User Message (" + title +

"): " + message

displayDlg = Fals

For more information about… See…

Using Microsoft Visual Basic “Creating the PrepWorks object with 
Visual Basic” on page 84

Properties and Methods ❑ “Properties” on page 85

❑ “Methods” on page 86

Contacting technical support “Reporting problems” on page ix
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Term Definition

profile A Microsoft Windows registry entry that contains the communication 
settings needed for communication between a device and the 
Velocity11 lab automation software.

protocol A sequence of tasks to be performed by the lab automation system.

run A process in which one or more microplates are processed. In a 
standalone device, the run consists of one cycle. In a lab automation 
system, a run can consist of multiple cycles that are automated.

task parameters The parameters associated with each task in a protocol. For example, in 
an aspirate task, the parameters include the volume (uL).

teachpoint A teachpoint is a set of coordinates that define a set of coordinates that 
tells the pipette head exactly where to move to perform a task for a 
particular type of labware.
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A
acceleration property, 80
adding

labware entries, 63
liquid library entries, 79
protocol task, 30
user accounts, 16

Administrator permission, 15
Aspirate parameters, liquid library, 80
Aspirate task, 40
automation interface, 84

C
Column-wise teachpoint to well property, 71
Column-wise well to well property, 71
commands quick reference, 5
compiling a protocol, 54
component relationships, 7
computer requirements, 10
Configure Shelves task, 34
configuring compiler options, 55
copying data, 20

D
data, copying, 20
default user account, password for, 16
defining

general properties for labware, 67
labware classes, 73
plate properties, 68

deleting labware entries, 65
deleting user accounts, 16
Dispense parameters, liquid library, 80
Dispense task, 42
Disposable-tip length property, 71

E
email registry key, 21
errors, reporting, ix
Events, automation interface, 88

G
Guest permission, 15

H
hardware, reporting problems, ix

I
image, labware, 72
installing PrepWorks, 10

L
labware

adding definitions, 63
defining plate properties, 68
defining well properties, 69
deleting entries, 65
general properties, defining, 67
inserting image, 72
renaming entries, 66
standards for, 62

labware class
associating plate with, 74
defining, 73

Labware Editor overview, 60
labware requirements, 62
liquid library, adding entries, 79
log options, configuring, 19
logging in to PrepWorks, 17
Loop task, 51

M
main window, 4
Methods, automation interface, 86
microplate requirements, 62
Mix task, 45
moving data, 20

N
No access permission, 15

O
operation workflow, basic, 9
Operator permission, 15
overview, PrepWorks, 2
overview, user interface, 4

P
palettes, main window, 4
passwords

first login, 16
setting or changing, 18

PDF guide, viii

Index
Note: You can also search our technical documentation on our website at www.velocity11.com.

http://www.velocity11.com/support/support.html


Index
PrepWorks User Guide

94

permission levels, 15
plate properties, defining, 68
post-aspirate delay property, 80
post-dispense delay property, 81
profile, defined, 6
Properties, automation interface, 85
property

acceleration, 80
Column-wise teachpoint to well, 71
Column-wise well to well, 71
Disposable-tip length, 71
post-aspirate delay, 80
post-dispense delay, 81
Row-wise teachpoint to well, 71
Row-wise well to well, 71
thickness, 68
velocity, 80
well depth, 70
well diameter, 70
well geometry, 70
well/tip volume, 70
well-bottom shape, 70
z-axis acceleration into wells, 80, 81
z-axis acceleration out of wells, 80, 81
z-axis speed into wells, 80
z-axis velocity into wells, 80
z-axis velocity out of wells, 80, 81

protocols
adding a task, 30
compiler options, 55
compiling and saving, 54
creating, 30
log options, configuring, 19
opening, 25
running, 26
saving, 55
task descriptions, 32
workflow, 24

Q
quadrants, microplates, 38
quick reference, toolbars, 5

R
registry keys

importing, 21
installing, 11
sending email, 21

relationships, component, 7
renaming a labware entry, 66
Reservoir task, 49
Row-wise teachpoint to well property, 71
Row-wise well to well property, 71

run, protocol, 24

S
saving a protocol, 54
serial number location, ix
setting or changing passwords, 18
software

conflicts, 10
overview, 2
protocol definition, 6
reporting errors, ix
uninstalling, 12
version number, vii

starting PrepWorks, 14

T
tasks

adding to protocols, 30
Aspirate, 40
Configure Shelves, 34
Dispense, 42
Loop, 51
Mix, 45
overview, 32
Reservoir, 49
specifying a quadrant, 38
Tips Off, 36
Tips On, 36
User Message, 52

teachpoint definition, 6
Technician permission, 15
thickness property, 68
Tips Off task, 36
Tips On task, 36
toolbars, 5

U
uninstalling PrepWorks, 12
user accounts, managing, 15
user guide, vii
User Message task, 52

V
velocity property, 80
version numbers, software, vii
Visual Basic, PrepWorks automation interface, 84

W
well depth property, 70
well diameter property, 70
well geometry property, 70
well properties, labware, 69
well/tip volume property, 70
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well-bottom shape property, 70
window, PrepWorks, 4
Windows registry

importing registry keys, 21
installing registry keys, 11
sending email, 21

workflow
creating a protocol, 30
overview, 9

performing a run, 24

Z
z-axis acceleration into wells property, 80, 81
z-axis acceleration out of wells property, 80, 81
z-axis speed into wells property, 80
z-axis velocity into wells property, 80
z-axis velocity out of wells property, 80, 81
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